
ソフトウェアおよびコンフィギュレーショ

ン

この章では、Cisco ASAソフトウェアおよびコンフィギュレーションの管理方法について説明
します。

•ソフトウェアのアップグレード（1ページ）
• ROMMONを使用したイメージのロード（ASA 5506-X、5508-X、5516-X、および ISA
3000）（1ページ）

• ROMMONイメージのアップグレード（ASA5506-X、5508-X、5516-X、および ISA3000）
（3ページ）

• ASA 5506W-Xワイヤレスアクセスポイントのイメージの回復およびロード（5ページ）
•ソフトウェアのダウングレード（5ページ）
•ファイルの管理（12ページ）
• ASAイメージ、ASDM、およびスタートアップコンフィギュレーションの設定（20ペー
ジ）

•コンフィギュレーションまたはその他のファイルのバックアップと復元（23ページ）
•システム再起動のスケジュール（30ページ）
• Auto Updateの設定（31ページ）
•ソフトウェアとコンフィギュレーションの履歴（38ページ）

ソフトウェアのアップグレード
完全なアップグレードの手順については、『Cisco ASAUpgrade Guide』を参照してください。

ROMMONを使用したイメージのロード（ASA 5506-X、
5508-X、5516-X、および ISA 3000）

TFTPを使用して ROMMONモードから ASAへソフトウェアイメージをロードするには、次
の手順を実行します。
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手順

ステップ 1 ASAハードウェアまたは ISA 3000コンソールへのアクセスに従って、ASAのコンソールポー
トに接続します。

ステップ 2 ASAの電源を切ってから、再び電源をオンにします。

ステップ 3 スタートアップの間に、ROMMONモードに入るようにプロンプト表示されたら、Escapeキー
を押します。

ステップ 4 ROMMONモードで、IPアドレス、TFTPサーバアドレス、ゲートウェイアドレス、ソフト
ウェアイメージファイル、およびポートを含む、ASAに対するインターフェイス設定を次の
ように定義します。

rommon #1> interface gigabitethernet0/0
rommon #2> address 10.86.118.4
rommon #3> server 10.86.118.21
rommon #4> gateway 10.86.118.21
rommon #5> file asa961-smp-k8.bin

ネットワークへの接続がすでに存在することを確認してください。

インターフェイスコマンドは ASA 5506-X、ASA 5508-X、および ASA 5516-Xプラッ
トフォームで無視されるため、これらのプラットフォームでManagement 1/1インター
フェイスから TFTPリカバリを実行する必要があります。

（注）

ステップ 5 設定を検証します。

rommon #6> set
ROMMON Variable Settings:
ADDRESS=10.86.118.3
SERVER=10.86.118.21
GATEWAY=10.86.118.21
PORT=GigabitEthernet0/0
VLAN=untagged
IMAGE=asa961-smp-k8.bin
CONFIG=
LINKTIMEOUT=20
PKTTIMEOUT=4
RETRY=20

ステップ 6 TFTPサーバーに pingを送信します。

rommon #7> ping server
Sending 20, 100-byte ICMP Echoes to server 10.86.118.21, timeout is 4 seconds:

Success rate is 100 percent (20/20)

ステップ 7 ネットワーク設定を、後で使用できるように保管しておきます。

rommon #8> sync
Updating NVRAM Parameters...
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ステップ 8 システムソフトウェアイメージをロードします。

rommon #9> tftpdnld
ROMMON Variable Settings:
ADDRESS=10.86.118.3
SERVER=10.86.118.21
GATEWAY=10.86.118.21
PORT=GigabitEthernet0/0
VLAN=untagged
IMAGE=asa961-smp-k8.bin
CONFIG=
LINKTIMEOUT=20
PKTTIMEOUT=4
RETRY=20

tftp asa961-smp-k8.bin@10.86.118.21 via 10.86.118.21

Received 14450688 bytes

Launching TFTP Image...
Cisco ASA Security Appliance admin loader (3.0) #0: Mon Mar 5 16:00:07 MST 2016

Loading...

ソフトウェアイメージが正常にロードされると、ASAは自動的に ROMMONモードを終了し
ます。

ステップ 9 ROMMONモードから ASAを起動する場合、システムイメージはリロード間で保持されない
ため、やはりイメージをフラッシュメモリにダウンロードする必要があります。ソフトウェア

のアップグレード（1ページ）を参照してください。

ROMMONイメージのアップグレード（ASA 5506-X、
5508-X、5516-X、および ISA 3000）

ASA 5506-Xシリーズ、ASA 5508-X、ASA 5516-X、および ISA 3000の ROMMONイメージを
アップグレードするには、次の手順に従います。 ASAモデルの場合、システムの ROMMON
バージョンは 1.1.8以上である必要があります。最新バージョンへのアップグレードを推奨し
ます。

新バージョンへのアップグレードのみ可能です。ダウングレードはできません。

ASA 5506-X、5508-X、5516-Xの ROMMON 1.1.15へのアップグレード、および ISA 3000の
ROMMON1.0.5へのアップグレードには、以前のROMMONバージョンの 2倍の時間がかかり
ます（約 15分）。アップグレード中はデバイスの電源を再投入しないでください。アップグ
レードが 30分以内に完了しないか、または失敗した場合は、シスコテクニカルサポートに連
絡してください。デバイスの電源を再投入したり、リセットしたりしないでください。

注意
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始める前に

Cisco.comから新しいROMMONイメージを取得して、サーバー上に置いてASAにコピーしま
す。ASAは、FTPサーバー、TFTPサーバー、SCPサーバー、HTTP（S）サーバー、および
SMBサーバーをサポートしています。次の URLからイメージをダウンロードします。

• ASA 5506-X、5508-X、5516-X： https://software.cisco.com/download/home/286283326/type

• ISA 3000： https://software.cisco.com/download/home/286288493/type

手順

ステップ 1 ROMMONイメージを ASAフラッシュメモリにコピーします。この手順では、FTPコピーを
表示します。他のサーバータイプのシンタックスの場合は copy ?と入力します。

copy ftp://[username:password@]server_ip/asa5500-firmware-xxxx.SPA
disk0:asa5500-firmware-xxxx.SPA

ステップ 2 現在のバージョンを確認するには、showmoduleコマンドを入力して、MACアドレス範囲テー
ブルのMod 1の出力で Fwバージョンを調べます。

ciscoasa# show module
[...]
Mod MAC Address Range Hw Version Fw Version Sw Version
---- --------------------------------- ------------ ------------ ---------------

1 7426.aceb.ccea to 7426.aceb.ccf2 0.3 1.1.5 9.4(1)
sfr 7426.aceb.cce9 to 7426.aceb.cce9 N/A N/A

ステップ 3 ROMMONイメージをアップグレードします。

upgrade rommon disk0:asa5500-firmware-xxxx.SPA

例：

ciscoasa# upgrade rommon disk0:asa5500-firmware-1108.SPA
Verifying file integrity of disk0:/asa5500-firmware-1108.SPA

Computed Hash SHA2: d824bdeecee1308fc64427367fa559e9
eefe8f182491652ee4c05e6e751f7a4f
5cdea28540cf60acde3ab9b65ff55a9f
4e0cfb84b9e2317a856580576612f4af

Embedded Hash SHA2: d824bdeecee1308fc64427367fa559e9
eefe8f182491652ee4c05e6e751f7a4f
5cdea28540cf60acde3ab9b65ff55a9f
4e0cfb84b9e2317a856580576612f4af

Digital signature successfully validated
File Name : disk0:/asa5500-firmware-1108.SPA
Image type : Release

Signer Information
Common Name : abraxas
Organization Unit : NCS_Kenton_ASA
Organization Name : CiscoSystems

Certificate Serial Number : 553156F4
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Hash Algorithm : SHA2 512
Signature Algorithm : 2048-bit RSA
Key Version : A

Verification successful.
Proceed with reload? [confirm]

ステップ 4 プロンプトが表示されたら、確認して ASAをリロードします。

ASAがROMMONイメージをアップグレードして、その後オペレーティングシステムをリロー
ドします。

ASA 5506W-Xワイヤレスアクセスポイントのイメージの
回復およびロード

TFTPを使用してソフトウェアイメージを回復して ASA 5506W-Xにロードするには、次の手
順を実行します。

手順

ステップ 1 アクセスポイント（AP）へのセッションを確立し、AP ROMMON（ASA ROMMONではな
く）を開始します。

ciscoasa# hw-module module wlan recover image

ステップ 2 Cisco Aironetアクセスポイント Cisco IOSソフトウェアコンフィギュレーションガイド [英語]
の手順に従います。

ソフトウェアのダウングレード
多くの場合、ASAソフトウェアをダウングレードし、以前のソフトウェアバージョンからバッ
クアップ設定を復元することができます。ダウングレードの方法は、ASAプラットフォームに
よって異なります。

ダウングレードに関するガイドラインおよび制限事項

ダウングレードする前に、次のガイドラインを参照してください。

•クラスタリング用の公式のゼロダウンタイムダウングレードのサポートはありません。
ただし場合によっては、ゼロダウンタイムダウングレードが機能します。ダウングレー
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ドに関する次の既知の問題を参照してください。この他の問題が原因でクラスタユニット

のリロードが必要になることもあり、その場合はダウンタイムが発生します。

•クラスタリングを含む9.9(1)より前のリリースへのダウングレード：9.9(1)以降では、
バックアップの配布が改善されています。クラスタに3つ以上のユニットがある場合
は、次の手順を実行する必要があります。

1. クラスタからすべてのセカンダリユニットを削除します（クラスタはプライマリ
ユニットのみで構成されます）。

2. 1つのセカンダリユニットをダウングレードし、クラスタに再参加させます。

3. プライマリユニットでクラスタリングを無効にします。そのユニットをダウング
レードし、クラスタに再参加させます。

4. 残りのセカンダリユニットをダウングレードし、それらを一度に 1つずつクラス
タに再参加させます。

•クラスタサイトの冗長性を有効にする場合は、9.9(1)より前のリリースにダウング
レードします。ダウングレードする場合（または 9.9(1)より前のユニットをクラスタ
に追加する場合）は、サイトの冗長性を無効にする必要があります。そうしないと、

古いバージョンを実行しているユニットにダミーの転送フローなどの副作用が発生し

ます。

•クラスタリングおよび暗号マップを使用する場合に 9.8(1)からダウングレードする：
暗号マップが設定されている場合に 9.8 (1)からダウングレードすると、ゼロダウン
タイムダウングレードはサポートされません。ダウングレード前に暗号マップ設定を

クリアし、ダウングレード後に設定をもう一度適用する必要があります。

•クラスタリングユニットのヘルスチェックを 0.3～ 0.7秒に設定した状態で 9.8(1)か
らダウングレードする：（health-check holdtimeで）ホールド時間を 0.3～ 0.7秒に設
定した後で ASAソフトウェアをダウングレードすると、新しい設定はサポートされ
ないため、設定値はデフォルトの 3秒に戻ります。

•クラスタリング（CSCuv82933）を使用している場合に9.5(2)以降から9.5(1)以前にダ
ウングレードする：9.5(2)からダウングレードする場合、ゼロダウンタイムダウング
レードはサポートされません。ユニットがオンラインに戻ったときに新しいクラスタ

が形成されるように、すべてのユニットをほぼ同時にリロードする必要があります。

ユニットが順番にリロードされるのを待つと、クラスタを形成できなくなります。

•クラスタリングを使用する場合に 9.2(1)以降から 9.1以前にダウングレードする：ゼ
ロダウンタイムダウングレードはサポートされません。

•プラットフォームモードでの 9.13/9.14から 9.12以前への Firepower 2100のダウングレー
ドの問題：プラットフォームモードに変換した 9.13または 9.14を新規インストールした
Firepower 2100の場合：9.12以前にダウングレードすると、FXOSで新しいインターフェ
イスの設定や、既存のインターフェイスの編集ができなくなります（9.12以前ではプラッ
トフォームモードのみがサポートされていたことに注意してください）。バージョンを

9.13以降に戻すか、または FXOSの erase configurationコマンドを使用して設定をクリアす
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る必要があります。この問題は、元々以前のリリースから9.13または9.14にアップグレー
ドした場合は発生しません。新しいデバイスや再イメージ化されたデバイスなど、新規イ

ンストールのみが影響を受けます。（CSCvr19755）

•スマートライセンスの 9.10(1)からのダウングレード：スマートエージェントの変更によ
り、ダウングレードする場合、デバイスをCisco Smart SoftwareManagerに再登録する必要
があります。新しいスマートエージェントは暗号化されたファイルを使用するので、古い

スマートエージェントが必要とする暗号化されていないファイルを使用するために再登録

する必要があります。

• PBKDF2（パスワードベースのキー派生関数 2）ハッシュをパスワードで使用する場合に
9.5以前のバージョンにダウングレードする：9.6より前のバージョンはPBKDF2ハッシュ
をサポートしていません。9.6(1)では、32文字より長い enableパスワードおよびusername
パスワードで PBKDF2ハッシュを使用します。9.7(1)では、すべての新しいパスワード
は、長さに関わらず PBKDF2ハッシュを使用します（既存のパスワードは引き続きMD5
ハッシュを使用します）。ダウングレードすると、enableパスワードがデフォルト（空
白）に戻ります。ユーザー名は正しく解析されず、usernameコマンドが削除されます。
ローカルユーザーをもう一度作成する必要があります。

• ASAv用のバージョン 9.5(2.200)からのダウングレード：ASAvはライセンス登録状態を保
持しません。license smart register idtoken id_token forceコマンドで再登録する必要があり
ます（ASDMの場合、[Configuration] > [DeviceManagement] > [Licensing] > [Smart Licensing]
ページで [Force registration]オプションを使用）。Smart Software Managerから IDトークン
を取得します。

•元のトンネルがネゴシエートした暗号スイートをサポートしないソフトウェアバージョン
をスタンバイ装置が実行している場合でも、VPNトンネルがスタンバイ装置に複製されま
す。このシナリオは、ダウングレード時に発生します。その場合、VPN接続を切断して再
接続してください。

ダウングレード後に削除される互換性のない設定

以前のバージョンにダウングレードすると、それ以降のバージョンで導入されたコマンドは設

定から削除されます。ダウングレードする前に、ターゲットバージョンに対して設定を自動的

にチェックする方法はありません。新しいコマンドが ASAの新しい機能にいつ追加されたか
をリリースごとに表示できます。

show startup-config errorsコマンドを使用してダウングレードした後、拒否されたコマンドを
表示できます。ラボデバイスでダウングレードを実行できる場合は、実稼働デバイスでダウン

グレードを実行する前にこのコマンドを使用して効果を事前に確認できます。

場合によっては、ASAはアップグレード時にコマンドを新しいフォームに自動的に移行するた
め、バージョンによっては新しいコマンドを手動で設定しなかった場合でも、設定の移行に

よってダウングレードが影響を受けることがあります。ダウングレード時に使用できる古い設

定のバックアップを保持することを推奨します。8.3へのアップグレード時には、バックアッ
プが自動的に作成されます（<old_version>_startup_cfg.sav）。他の移行ではバックアップが作
成されません。ダウングレードに影響する可能性がある自動コマンド移行の詳細については、
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『ASAアップグレードガイド』の「バージョン固有のガイドラインと移行」を参照してくださ
い。

ダウングレードに関するガイドラインおよび制限事項（5ページ）の既知のダウングレード
の問題も参照してください。

たとえば、バージョン9.8(2)を実行している ASAには、次のコマンドが含まれています。

access-list acl1 extended permit sctp 192.0.2.0 255.255.255.0 198.51.100.0 255.255.255.0
username test1 password $sha512$1234$abcdefghijklmnopqrstuvwxyz privilege 15
snmp-server user snmpuser1 snmpgroup1 v3 engineID abcdefghijklmnopqrstuvwxyz encrypted
auth md5 12:ab:34 priv aes 128 12:ab:34

9.0(4)にダウングレードすると、起動時に次のエラーが表示されます。

access-list acl1 extended permit sctp 192.0.2.0 255.255.255.0 198.51.100.0 255.255.255.0

^
ERROR: % Invalid input detected at '^' marker.

username test1 password $sha512$1234$abcdefghijklmnopqrstuvwxyz pbkdf2 privilege 15
^

ERROR: % Invalid input detected at '^' marker.

snmp-server user snmpuser1 snmpgroup1 v3 engineID abcdefghijklmnopqrstuvwxyz encrypted
auth md5 12:ab:34 priv aes 128 12:ab:34

^
ERROR: % Invalid input detected at '^' marker.

この例では、access-list extendedコマンドでの sctpのサポートがバージョン 9.5(2)で、username
コマンドでのpbkdf2のサポートがバージョン9.6(1)で、snmp-server userコマンドでの engineID
のサポートがバージョン9.5(3)で追加されました。

アプライアンスモードでの Firepower 1000または Firepower 2100のダウ
ングレード

ASAのバージョンを古いバージョンに設定し、バックアップ設定をスタートアップコンフィ
ギュレーションに復元してからリロードすることによって、ASAソフトウェアのバージョンを
ダウングレードすることができます。

始める前に

この手順ではアップグレードする前に ASAのバックアップ設定を行う必要があるため、古い
設定を復元することができます。古い設定を復元しない場合は、新規または変更された機能を

表す互換性のないコマンドが存在する可能性があります。新しいコマンドは、ソフトウェアの

古いバージョンをロードすると拒否されます。

手順

ステップ 1 スタンドアロン、フェールオーバー、またはクラスタリング展開のために、『ASA Upgrade
Guide』のアップグレード手順を使用して、ASAソフトウェアの古いバージョンをロードしま
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す。この場合は、ASAの新しいバージョンではなく、古いバージョンを指定します。重要：ま
だ ASAをリロードしないでください。

ステップ 2 ASA CLIで、バックアップの ASA設定をスタートアップコンフィギュレーションにコピーし
ます。フェールオーバーの場合は、アクティブユニットでこの手順を実行します。この手順で

は、コマンドをスタンバイ装置に複製します。

copy old_config_url startup-config

writememoryを使用して実行コンフィギュレーションをスタートアップコンフィギュレーショ
ンに保存しないことが重要です。このコマンドは、バックアップ設定を上書きします。

例：

ciscoasa# copy disk0:/9.13.1_cfg.sav startup-config

ステップ 3 ASAをリロードします。

ASA CLI

reload

ASDM

[Tools] > [System Reload]を選択します。

プラットフォームモードでの Firepower 2100のダウングレード
バックアップ設定をスタートアップコンフィギュレーションに復元し、ASAのバージョンを
古いバージョンに設定してからリロードすることによって、ASAソフトウェアのバージョンを
ダウングレードすることができます。

始める前に

この手順ではアップグレードする前に ASAのバックアップ設定を行う必要があるため、古い
設定を復元することができます。古い設定を復元しない場合は、新規または変更された機能を

表す互換性のないコマンドが存在する可能性があります。新しいコマンドは、ソフトウェアの

古いバージョンをロードすると拒否されます。

手順

ステップ 1 ASA CLIで、バックアップの ASA設定をスタートアップコンフィギュレーションにコピーし
ます。フェールオーバーの場合は、アクティブユニットでこの手順を実行します。この手順で

は、コマンドをスタンバイ装置に複製します。

copy old_config_url startup-config

writememoryを使用して実行コンフィギュレーションをスタートアップコンフィギュレーショ
ンに保存しないことが重要です。このコマンドは、バックアップ設定を上書きします。

ソフトウェアおよびコンフィギュレーション
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例：

ciscoasa# copy disk0:/9.12.4_cfg.sav startup-config

ステップ 2 FXOSでは、スタンドアロン、フェールオーバー、またはクラスタリング展開のために、
FirepowerChassisManageまたはFXOSCLIを使用して、『ASAUpgradeGuide』のアップグレー
ド手順に従い、ASAソフトウェアの古いバージョンを使います。この場合は、ASAの新しい
バージョンではなく、古いバージョンを指定します。

Firepower 4100/9300のダウングレード
バックアップ設定をスタートアップコンフィギュレーションに復元し、ASAのバージョンを
古いバージョンに設定してからリロードすることによって、ASAソフトウェアのバージョンを
ダウングレードすることができます。

始める前に

•この手順ではアップグレードする前に ASAのバックアップ設定を行う必要があるため、
古い設定を復元することができます。古い設定を復元しない場合は、新規または変更され

た機能を表す互換性のないコマンドが存在する可能性があります。新しいコマンドは、ソ

フトウェアの古いバージョンをロードすると拒否されます。

• ASAの古いバージョンが、FXOSの現在のバージョンと互換性があることを確認します。
互換性がない場合は、古い ASA設定を復元する前に最初の手順として FXOSをダウング
レードします。ダウングレードされた FXOSも、（ダウングレードする前に）ASAの現
在のバージョンと互換性があることを確認してください。互換性を実現できない場合は、

ダウングレードを実行しないことをお勧めします。

手順

ステップ 1 ASA CLIで、バックアップの ASA設定をスタートアップコンフィギュレーションにコピーし
ます。フェールオーバーまたはクラスタリングの場合は、アクティブ/制御ユニットでこの手
順を実行します。この手順では、コマンドをスタンバイ/データユニットに複製します。

copy old_config_url startup-config

writememoryを使用して実行コンフィギュレーションをスタートアップコンフィギュレーショ
ンに保存しないことが重要です。このコマンドは、バックアップ設定を上書きします。

例：

ciscoasa# copy disk0:/9.8.4_cfg.sav startup-config

ステップ 2 FXOSでは、スタンドアロン、フェールオーバー、またはクラスタリング展開のために、
FirepowerChassisManageまたはFXOSCLIを使用して、『ASAUpgradeGuide』のアップグレー
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ド手順に従い、ASAソフトウェアの古いバージョンを使います。この場合は、ASAの新しい
バージョンではなく、古いバージョンを指定します。

ステップ 3 また、FXOSをダウングレードする場合は、スタンドアロン、フェールオーバー、またはクラ
スタリング展開のために、Firepower Chassis Managerまたは FXOS CLIを使用して、『ASA
Upgrade Guide』のアップグレード手順に従い、ASAソフトウェアの古いバージョンを使いま
す。

ASA 5500-Xまたは ISA 3000のダウングレード
ダウングレードでは、ASA5500-Xおよび ISA3000モデルで以下の機能を完了するためのショー
トカットが存在します。

•ブートイメージコンフィギュレーションのクリア（clear configure boot）。

•古いイメージへのブートイメージの設定（boot system）。

•（オプション）新たなアクティベーションキーの入力（activation-key）。

•実行コンフィギュレーションのスタートアップへの保存（writememory）。これにより、
BOOT環境変数を古いイメージに設定します。このため、リロードすると古いイメージが
ロードされます。

•古いコンフィギュレーションのバックアップをスタートアップコンフィギュレーションに
コピーします（copy old_config_ur startup-config）。

•リロード（reload）。

始める前に

•この手順ではアップグレードする前に ASAのバックアップ設定を行う必要があるため、
古い設定を復元することができます。

• ASA FirePOWERモジュールのバージョンがインストールされている場合は、ASAの古い
バージョンと互換性があることを確認します。FirePOWERモジュールを以前のメジャー
バージョンにダウングレードすることはできません。

手順

ステップ 1 [Tools] > [Downgrade Software]を選択します。

[Downgrade Software]ダイアログボックスが表示されます。

ステップ 2 ASAイメージの場合、[Select Image File]をクリックします。

[Browse File Locations]ダイアログボックスが表示されます。

ステップ 3 次のいずれかのオプションボタンをクリックします。
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• [Remote Server]：ドロップダウンリストで [ftp]、[smb]、[http]のいずれかを選択し、以前
のイメージファイルのパスを入力します。

• [Flash File System]：[Browse Flash]をクリックして、ローカルフラッシュファイルシステ
ムにある以前のイメージファイルを選択します。

ステップ 4 [Configuration]で [Browse Flash]をクリックし、移行前の設定ファイルを選択します。

ステップ 5 （任意）バージョン 8.3よりも前のアクティベーションキーに戻す場合は、[Activation Key]
フィールドで以前のアクティベーションキーを入力します。

ステップ 6 [Downgrade]をクリックします。

ファイルの管理
ASDMには、基本的なファイル管理タスクを実行するのに便利なファイル管理ツールセット
が用意されています。ファイル管理ツールにより、フラッシュメモリに保存されているファイ

ルの表示、移動、コピー、および削除、ファイルの転送、およびリモートストレージデバイ

ス（マウントポイント）のファイルの管理を行うことができます。

マルチコンテキストモードの場合、このツールはシステムのセキュリティコンテキストでだ

け使用できます。

（注）

ファイルアクセスの設定

ASAでは、FTPクライアント、セキュアコピークライアント、または TFTPクライアントを
使用できます。また、ASAをセキュアコピーサーバーとして設定することもできるため、コ
ンピュータでセキュアコピークライアントを使用できます。

FTPクライアントモードの設定

ASAでは、FTPサーバーとの間で、イメージファイルやコンフィギュレーションファイルの
アップロードおよびダウンロードを実行できます。パッシブFTPでは、クライアントは制御接
続およびデータ接続の両方を開始します。パッシブモードではデータ接続の受け入れ側となる

サーバーは、今回の特定の接続においてリッスンするポート番号を応答として返します。

手順

ステップ 1 [Configuration] > [Device Management] > [Management Access] > [File Access] > [FTP Client]ペイン
で、[Specify FTP mode as passive]チェックボックスをオンにします。

ステップ 2 [Apply]をクリックします。
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FTPクライアントのコンフィギュレーションが変更され、その変更内容が実行コンフィギュ
レーションに保存されます。

セキュアコピーサーバーとしての ASAの設定

ASA上でセキュアコピー（SCP）サーバーをイネーブルにできます。SSHによる ASAへのア
クセスを許可されたクライアントだけが、セキュアコピー接続を確立できます。

始める前に

•サーバーにはディレクトリサポートがありません。ディレクトリサポートがないため、
ASAの内部ファイルへのリモートクライアントアクセスは制限されます。

•サーバーでは、バナーまたはワイルドカードがサポートされていません。

• ASDM、その他のクライアントの HTTPSアクセスの設定に従って、ASAで SSHを有効
にします。

• SSHバージョン 2接続をサポートするには、ASAのライセンスに強力な暗号化
（3DES/AES）ライセンスが必要です。

•特に指定されていないかぎり、マルチコンテキストモードでは、システム実行スペース
で次の手順を実行します。まだシステムコンフィギュレーションモードに入っていない

場合、[Configuration] > [Device List]ペインで、アクティブなデバイスの IPアドレスの下に
ある [System]をダブルクリックします。

•セキュアコピーのパフォーマンスは、使用する暗号化アルゴリズムにある程度依存しま
す。デフォルトで、ASAは 3des-cbc aes128-cbc aes192-cbc aes256-cbc aes128-ctr aes192-ctr
aes256-ctrの順にアルゴリズムをネゴシエートします。提示された最初のアルゴリズム
（3des-cbc）が選択された場合、aes128-cbcなどの一層効率的なアルゴリズムが選択され
た場合よりも大幅にパフォーマンスが低下します。提示された暗号方式を変更するには、

[Configuration] > [Device Management] > [Advanced] > [SSH Ciphers]ペインを使用します。
たとえば、[Custom]を選択して aes128-cbcに設定します。

手順

ステップ 1 コンテキストモードによって次のように異なります。

•シングルモードの場合、[Configuration] > [DeviceManagement] > [ManagementAccess] > [File
Access] > [Secure Copy (SCP)]の順に選択します。

•マルチモードの場合、[Configuration] > [Device Management] > [Device Administration] >
[Secure Copy]の順に選択します。

ステップ 2 [Enable secure copy server]チェックボックスをオンにします。
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ステップ 3 （オプション）ASAは接続先の各 SCPサーバーの SSHホストキーを保存します。必要に応じ
て、ASAデータベースから手動でサーバとそのキーを追加または削除できます。

キーを追加するには、次の手順を実行します。

a) 新しいサーバーの [Add]をクリックするか、または信頼できる SSHホストのテーブルから
サーバーを選択し、[Edit]をクリックします。

b) 新しいサーバーの [Host]フィールドに、サーバーの IPアドレスを入力します。
c) [Add public key for the trusted SSH host]チェックボックスをオンにします。
d) 次のいずれかのキーを指定します。

•フィンガープリント：すでにハッシュされているキーを入力します。たとえば、show
コマンドの出力からコピーしたキーです。

•キー：SSHホストの公開キーまたはハッシュ値を入力します。キーストリングはリ
モートピアのBase64で符号化されたRSA公開キーです。オープン SSHクライアント
から（言い換えると .ssh/id_rsa.pubファイルから）公開キー値を取得できます。Base64
で符号化された公開キーを送信した後、SHA-256によってそのキーがハッシュされま
す。

キーを削除するには、信頼できる SSHホストのテーブルからサーバーを選択し、[Delete]をク
リックします。

ステップ 4 （オプション）新しいホストキーが検出されたときに通知を受け取るには、[Inform me when a
new host key is detected]チェックボックスをオンにします。

デフォルトで、このオプションは有効になっています。このオプションがイネーブルになって

いる場合、ASAにまだ格納されていないホストキーを許可または拒否するように求められま
す。このオプションがディセーブルになっている場合、ASAは過去に保存されたことがないホ
ストキーを自動的に許可します。

ステップ 5 [適用（Apply）]をクリックします。

例

外部ホストのクライアントから、SCPファイル転送を実行します。たとえば、Linux
では次のコマンドを入力します。

scp -v -pw password [path/]source_filename
username@asa_address:{disk0|disk1}:/[path/]dest_filename

-vは冗長を表します。-pwが指定されていない場合は、パスワードの入力を求めるプ
ロンプトが表示されます。

ASA TFTPクライアントのパス設定

TFTPは、単純なクライアント/サーバーファイル転送プロトコルで、RFC783およびRFC1350
Rev. 2で規定されています。TFTPサーバーとの間でファイルをコピーできるように、ASAを
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TFTPクライアントとして設定できます。これにより、コンフィギュレーションファイルを
バックアップし、それらを複数の ASAにプロパゲートできます。

ここでは、TFTPサーバーへのパスを事前定義できるため、copyおよび configure netなどのコ
マンドで入力する必要がなくなります。

手順

ステップ 1 [Configuration] > [Device Management] > [Management Access] > [File Access] > [TFTP Client]
の順に選択し、[Enable]チェックボックスをオンにします。

ステップ 2 [Interface Name]ドロップダウンリストから、TFTPクライアントとして使用するインターフェ
イスを選択します。

ステップ 3 コンフィギュレーションファイルの保存先とする TFTPサーバーの IPアドレスを [IP Address]
フィールドに入力します。

ステップ 4 コンフィギュレーションファイルの保存先とする TFTPサーバーへのパスを [Path]フィールド
に入力します。

例：/tftpboot/asa/config3

ステップ 5 Applyをクリックします。

マウントポイントの追加

CIFSマウントポイントまたは FTPマウントポイントを追加できます。

CIFSマウントポイントの追加

共通インターネットファイルシステム（CIFS）マウントポイントを定義するには、次の手順
を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Management Access] > [File Access] > [Mount-Points]
の順に選択し、[Add] > [CIFS Mount Point]の順にクリックします。

[Add CIFS Mount Point]ダイアログボックスが表示されます。

ステップ 2 [Enable mount point]チェックボックスをオンにします。

これにより、ASA上の CIFSファイルシステムが UNIXのファイルツリーに接続されます。

ステップ 3 [Mount Point Name]フィールドに、既存の CIFSが存在する位置の名前を入力します。

ステップ 4 [Server Name]フィールドまたは [IP Address]フィールドに、マウントポイントを配置するサー
バーの名前または IPアドレスを入力します。

ステップ 5 [Share Name]フィールドに、CIFSサーバー上のフォルダの名前を入力します。
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ステップ 6 [NT Domain Name]フィールドに、サーバーが常駐する NTドメインの名前を入力します。

ステップ 7 サーバーに対するファイルシステムのマウントを認可されているユーザーの名前を、[User
Name]フィールドに入力します。

ステップ 8 サーバーに対するファイルシステムのマウントを認可されているユーザーのパスワードを、

[Password]フィールドに入力します。

ステップ 9 [Confirm Password]フィールドにパスワードを再入力します。

ステップ 10 [OK]をクリックします。

[Add CIFS Mount Point]ダイアログボックスが閉じます。

ステップ 11 [Apply]をクリックします。

FTPマウントポイントの追加

FTPマウントポイントの場合、FTPサーバーには UNIXのディレクトリリストスタイルが必
要です。Microsoft FTPサーバーには、デフォルトでMS-DOSディレクトリリストスタイルが
あります。

手順

ステップ 1 [Configuration] > [Device Management] > [Management Access] > [File Access] > [Mount-Points]
の順に選択し、[Add] > [FTP Mount Point]の順にクリックします。

[Add FTP Mount Point]ダイアログボックスが表示されます。

ステップ 2 [Enable]チェックボックスを選択します。

これにより、ASA上の FTPファイルシステムが UNIXのファイルツリーに接続されます。

ステップ 3 [Mount Point Name]フィールドに、既存の FTPが存在する位置の名前を入力します。

ステップ 4 [Server Name]フィールドまたは [IP Address]フィールドに、マウントポイントを配置するサー
バーの名前または IPアドレスを入力します。

ステップ 5 [Mode]フィールドで、オプションボタン（[Active]または [Passive]）をクリックして FTPモー
ドを選択します。[Passive]モードを選択した場合、クライアントでは、FTPコントロール接続
とデータ接続がともに起動します。サーバーは、この接続をリッスンするポートの番号で応答

します。

ステップ 6 FTPファイルサーバへのディレクトリパス名を [Path to Mount]フィールドに入力します。

ステップ 7 サーバーに対するファイルシステムのマウントを認可されているユーザーの名前を、[User
Name]フィールドに入力します。

ステップ 8 サーバーに対するファイルシステムのマウントを認可されているユーザーのパスワードを、

[Password]フィールドに入力します。

ステップ 9 [Confirm Password]フィールドにパスワードを再入力します。

ステップ 10 [OK]をクリックします。
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[Add FTP Mount Point]ダイアログボックスが閉じます。

ステップ 11 [Apply]をクリックします。

ファイル管理ツールへのアクセス

ファイル管理ツールを使用するには、次の手順を実行します。

手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [File Management]の順に選択しま
す。

[File Management]ダイアログボックスが表示されます。

• [Folders]ペインには、ディスク上にあるフォルダが表示されます。

• [Flash Space]は、フラッシュメモリの合計容量と、使用可能なメモリ容量を示します。

• [Files]領域には、選択したフォルダのファイルについて次の情報が表示されます。

•パス

•ファイル名

•サイズ（バイト単位）

•修正時刻

•選択したファイルの種類（ブートコンフィギュレーション、ブートイメージファイ
ル、ASDMイメージファイル、SVCイメージファイル、CSDイメージファイル、ま
たは APCFイメージファイル）を示す、ステータス

ステップ 2 選択したファイルをブラウザに表示するには、[View]をクリックします。

ステップ 3 選択したファイルを切り取って別のディレクトリに貼り付けるには、[Cut]をクリックします。

ステップ 4 選択したファイルをコピーして別のディレクトリに貼り付けるには、[Copy]をクリックしま
す。

ステップ 5 コピーしたファイルを選択した場所に貼り付けるには、[Paste]をクリックします。

ステップ 6 選択したファイルをフラッシュメモリから削除するには、[Delete]をクリックします。

ステップ 7 ファイルの名前を変更するには、[Rename]をクリックします。

ステップ 8 ファイルを保存するディレクトリを新規作成するには、[New Directory]をクリックします。

ステップ 9 [File Transfer]ダイアログボックスを開くには、[File Transfer]をクリックします。詳細について
は、「ファイルの転送（18ページ）」を参照してください。
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ステップ 10 [ManagePoints]ダイアログボックスを開くには、[MountPoints]をクリックします。詳細につい
ては、マウントポイントの追加 （15ページ）を参照してください。

ファイルの転送

File Transferツールにより、ローカルにあるファイルとリモートにあるファイルを転送できま
す。PCまたはフラッシュファイルシステムのローカルファイルを ASAとの間で転送できま
す。HTTP、HTTPS、TFTP、FTP、または SMBを使用して、ASAとの間でファイルを転送で
きます。

IPS SSPソフトウェアモジュールの場合、IPSソフトウェアを disk0にダウンロードする前に、
フラッシュメモリに少なくとも50%の空きがあることを確認してください。IPSをインストー
ルするときに、IPSのファイルシステム用に内部フラッシュメモリの 50%が予約されます。

（注）

ローカル PCとフラッシュ間でのファイル転送

ローカルPCとフラッシュファイルシステムとの間でファイルを転送するには、次の手順を実
行します。

手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [File Management]の順に選択しま
す。

[File Management]ダイアログボックスが表示されます。

ステップ 2 [File Transfer]の横にある下矢印をクリックし、続いて [Between Local PC and Flash]をクリック
します。

[File Transfer]ダイアログボックスが表示されます。

ステップ 3 ローカル PCまたはフラッシュファイルシステムのどちらかで、アップロードまたはダウン
ロードしたいファイルを選択し、目的の場所にドラッグします。または、ローカル PCまたは
フラッシュファイルシステムのどちらかで、アップロードまたはダウンロードしたいファイ

ルを選択し、右矢印または左矢印をクリックし、目的の場所にファイルを転送します。

ステップ 4 完了したら [Close]をクリックします。

リモートサーバーとフラッシュ間でのファイル転送

リモートサーバーとフラッシュファイルシステムとの間でファイルを転送するには、次の手

順を実行します。

ソフトウェアおよびコンフィギュレーション

18

ソフトウェアおよびコンフィギュレーション

ファイルの転送



手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [File Management]の順に選択しま
す。

[File Management]ダイアログボックスが表示されます。

ステップ 2 [File Transfer]ドロップダウンリストで下矢印をクリックし、[Between Remote Server and Flash]
をクリックします。

[File Transfer]ダイアログボックスが表示されます。

ステップ 3 リモートサーバーからファイルを転送するには、[Remote server]オプションをクリックしま
す。

ステップ 4 転送対象になるソースファイルを定義します。

a) （オプション）ASAがサーバーとの通信に使用するインターフェイスを指定します。イン
ターフェイスを指定しない場合、ASAは管理専用のルーティングテーブルをチェックし
ます。ここで一致が見つからない場合はデータのルーティングテーブルをチェックしま

す。

b) サーバーの IPアドレスを含めたファイルの場所へのパスを選択します。

ファイル転送は IPv4および IPv6のアドレスをサポートしています。（注）

c) FTPの場合はリモートサーバーのタイプを、HTTPまたは HTTPSの場合はリモートサー
バーのポート番号を入力します。有効な FTPタイプは次のとおりです。

• ap：パッシブモードの ASCIIファイル

• an：非パッシブモードの ASCIIファイル

• ip：パッシブモードのバイナリイメージファイル

• in：非パッシブモードのバイナリイメージファイル

ステップ 5 フラッシュファイルシステムからファイルを転送するには、[Flash file system]オプションを選
択します。

ステップ 6 ファイルの場所へのパスを入力するか、[Browse Flash]をクリックしてファイルの場所を指定
します。

ステップ 7 また、CLIにより、スタートアップコンフィギュレーション、実行コンフィギュレーション、
または SMBファイルシステムからファイルをコピーすることもできます。Copyコマンドの
使用方法については、CLIコンフィギュレーションガイドを参照してください。

ステップ 8 転送するファイルの宛先を定義します。

a) フラッシュファイルシステムにファイルを転送するには、[Flash file system]オプションを
選択します。

b) ファイルの場所へのパスを入力するか、[BrowseFlash]をクリックしてファイルの場所を指
定します。
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ステップ 9 リモートサーバーにファイルを転送するには、[Remote server]オプションを選択します。

a) （オプション）ASAがサーバーとの通信に使用するインターフェイスを指定します。イン
ターフェイスを指定しない場合、ASAは管理専用のルーティングテーブルをチェックし
ます。ここで一致が見つからない場合はデータのルーティングテーブルをチェックしま

す。

b) ファイルの場所へのパスを入力します。
c) FTP転送の場合はタイプを入力します。有効なタイプは次のとおりです。

• ap：パッシブモードの ASCIIファイル

• an：非パッシブモードの ASCIIファイル

• ip：パッシブモードのバイナリイメージファイル

• in：非パッシブモードのバイナリイメージファイル

ステップ 10 [Transfer]をクリックしてファイル転送を開始します。

[Enter Username and Password]ダイアログボックスが表示されます。

ステップ 11 リモートサーバーのユーザー名、パスワード、ドメイン（必要な場合）が表示されます。

ステップ 12 [OK]をクリックし、ファイル転送を続行します。

ファイル転送プロセスには数分かかる場合があります。必ず終了するまでお待ちください。

ステップ 13 ファイル転送が完了したら [Close]をクリックします。

ASAイメージ、ASDM、およびスタートアップコンフィ
ギュレーションの設定

複数の ASAまたは ASDMイメージがある場合は、ブートするイメージを指定する必要があり
ます。イメージを設定しない場合はデフォルトのブートイメージが使用され、そのイメージは

意図されたものではない可能性があります。スタートアップコンフィギュレーションでは、コ

ンフィギュレーションファイルを任意で指定できます。

次のモデルのガイドラインを参照してください。

• Firepower 4100/9300シャーシ：ASAのアップグレードは FXOSによって管理されます。
ASAオペレーティングシステム内で ASAをアップグレードすることはできないため、
ASAイメージに対してこの手順を使用しないでください。ASAと FXOSを個別にアップ
グレードできます。この 2つは FXOSディレクトリリストに別々に表示されます。ASA
パッケージには必ず ASDMが含まれています。

•プラットフォームモードの Firepower 2100：ASA、ASDM、および FXOSのイメージは 1
つのパッケージに一緒にバンドルされています。パッケージの更新はFXOSによって管理
されます。ASAオペレーティングシステム内でASAをアップグレードすることはできな
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いため、ASAイメージに対してこの手順を使用しないでください。ASAと FXOSを個別
にアップグレードすることはできません。常にバンドルされています。

•アプライアンスモードの Firepower 1000および 2100：ASA、ASDM、および FXOSのイ
メージは1つのパッケージに一緒にバンドルされています。パッケージの更新は、次の手
順を使用して ASAによって管理されます。これらのプラットフォームでは、ブートする
イメージを識別するためにASAが使用されますが、基盤となるメカニズムはレガシーASA
とは異なります。詳細については、以下のコマンドの説明を参照してください。

• FirepowerモデルのASDM：ASDMはASAオペレーティングシステム内からアップグレー
ドできるため、バンドルされたASDMイメージのみを使用する必要はありません。プラッ
トフォームモードの Firepower 2100ではFirepower 4100/9300、手動でアップロードする
ASDMイメージは FXOSイメージリストに表示されません。ASAから ASDMイメージを
管理する必要があります。

ASAバンドルをアップグレードすると、同じ名前
（asdm.bin）であるため、バンドル内のASDMイメー
ジが ASA上の前の ASDMバンドルイメージに置き換
わります。ただし、アップロードした別の ASDMイ
メージ（たとえばasdm-782.bin）を手動で選択すると、
バンドルアップグレード後も引き続き同じイメージが

使用されます。互換性のあるASDMバージョンを実行
していることを確認するには、バンドルをアップグレー

ドする前に ASDMをアップグレードするか、または
ASAバンドルをアップグレードする直前に、バンドル
されたASDMイメージ（asdm.bin）を使用するように
ASAを再設定する必要があります。

（注）

• ASAv：初期導入時の ASAvパッケージは、読み取り専用 boot:/パーティション内に ASA
イメージを配置します。ASAvをアップグレードする際は、フラッシュメモリ内の別のイ
メージを指定します。後でコンフィギュレーションをクリアすると、ASAvは元の展開の
イメージをロードするようになる点に注意してください。また、初期導入時のASAvパッ
ケージには、フラッシュメモリ内に配置されるASDMイメージも含まれています。ASDM
イメージを個別にアップグレードできます。

次のデフォルト設定を参照してください。

• ASAイメージ：

• Firepower 1000およびアプライアンスモードのFirepower 2100：以前実行していたブー
トイメージをブートします。

•その他の物理 ASA：内部フラッシュメモリ内で見つかった最初のアプリケーション
イメージをブートします。

• ASAv：最初に展開したときに作成された、読み取り専用の boot:/パーティションに
あるイメージをブートします。
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• Firepower 4100/9300シャーシ：どの ASAイメージをブートするかは FXOSシステム
によって決定されます。この手順を使用して ASAイメージを設定することはできま
せん。

•プラットフォームモードの Firepower 2100：どのASA/FXOSパッケージをブートする
かは FXOSシステムによって決定されます。この手順を使用して ASAイメージを設
定することはできません。

•すべてのASA上のASDMイメージ：内部フラッシュメモリ内で見つかった（この場所に
イメージがない場合は外部フラッシュメモリ内で見つかった）最初の ASDMイメージを
ブートします。

•スタートアップコンフィギュレーション：デフォルトで、ASAは、隠しファイルである
スタートアップコンフィギュレーションからブートします。

手順

ステップ 1 [設定（Configuration）] > [デバイス管理（Device Management）] > [システムイメージ/設定
（System Image/Configuration）] > [ブートイメージ/設定（Boot Image/Configuration）]を選
択します。

アプライアンスモードの Firepower 1000、2100：1つのイメージのみが追加できます。新しい
イメージにアップグレードする場合は、以前に設定したイメージを削除する必要があります。

この変更を適用すると、システムによってアクションが実行されます。システムはイメージを

検証して解凍し、ブート場所 (FXOSによって管理される disk0の内部ロケーション)にコピー
します。ASAをリロードすると、新しいイメージがロードされます。リロードする前に注意し
てください。ブートイメージの場所を削除して再適用すると、ブートロケーションから新しい

イメージを削除できます。そのため、現在のイメージは引き続き実行されます。この変更を適

用した後、ASAのフラッシュメモリから元のイメージファイルを削除することもできます。ま
た、ASAはブート場所から正しく起動します。他のモデルとは異なり、スタートアップコン
フィギュレーション内のこのコマンドは、ブートイメージには影響しません。リロード時に

は、最後にロードされたブートイメージが常に実行されます。Ciscoダウンロードサイトから
ロードできるのは、元のファイル名のイメージのみです。ファイル名を変更した場合はロード

されません。

他のモデル：起動イメージとして使用するバイナリイメージファイルは、ローカルから 4つ
まで指定できます。また TFTPサーバーのイメージを 1つ指定して、そこからデバイスをブー
トできます。TFTPサーバーに格納されているイメージを指定する場合は、そのファイルをリ
スト内の先頭に配置する必要があります。デバイスが、イメージのロード元の TFTPサーバに
到達できない場合は、フラッシュメモリに保存されているリスト内の次のイメージファイル

のロードが試行されます。

ステップ 2 [ブートイメージ/設定（Boot Image/Configuration）]ペインで [追加（Add）]をクリックしま
す。

ステップ 3 ブートするイメージを参照します。TFTPイメージの場合は、[ファイル名（FileName）]フィー
ルドに TFTP URLを入力します。[OK]をクリックします。
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ステップ 4 [上へ移動（Move Up）]ボタンと [下へ移動（Move Down）]ボタンを使用してイメージの順番
を並べ替えます。

ステップ 5 （オプション）[ブート設定ファイルパス（Boot Configuration File Path）]フィールドで、[フ
ラッシュを参照（BrowseFlash）]をクリックしてコンフィギュレーションを選択してスタート
アップコンフィギュレーションファイルを指定します。[OK]をクリックします。

ステップ 6 [ASDMイメージファイルパス（ASDM Image File Path）]フィールドで、[フラッシュを参照
（Browse Flash）]をクリックしてイメージを選択して ASDMイメージを指定します。[OK]を
クリックします。

ステップ 7 [Apply]をクリックします。

コンフィギュレーションまたはその他のファイルのバッ

クアップと復元
システム障害に備えて、コンフィギュレーションファイルなどのシステムファイルを定期的

にバックアップすることを推奨します。

完全なシステムバックアップまたは復元の実行

次の手順では、コンフィギュレーションおよびイメージの zipバックアップ zipファイルへの
バックアップおよび復元方法と、そのファイルのローカルコンピュータへの転送方法について

説明します。

バックアップまた復元を開始する前に

•バックアップまたは復元を開始する前に、バックアップまたは復元場所に使用可能なディ
スク領域が少なくとも 300 MBある必要があります。

• ASAは、シングルコンテキストモードである必要があります。

•バックアップ中またはバックアップ後にコンフィギュレーションを変更した場合、その変
更内容はバックアップに含められません。バックアップの実行後にコンフィギュレーショ

ンを変更してから復元を実行した場合、このコンフィギュレーションの変更は上書きされ

ます。結果として、ASAは異なる挙動をすることもあります。

•一度に開始できるバックアップまたは復元は 1つだけです。

•コンフィギュレーションは、元のバックアップを実行したときと同じ ASAバージョンに
のみ復元できます。復元ツールを使用して、ASAの異なるバージョン間でコンフィギュ
レーションを移行することはできません。コンフィギュレーションの移行が必要な場合、

ASAは、新しいASAOSをロードした時に常駐するスタートアップコンフィギュレーショ
ンを自動的にアップグレードします。
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•クラスタリングを使用する場合、バックアップまたは復元できるのは、スタートアップコ
ンフィギュレーション、実行コンフィギュレーション、およびアイデンティティ証明書の

みです。ユニットごとに別々にバックアップを作成および復元する必要があります。

•フェールオーバーを使用する場合、バックアップの作成および復元は、アクティブユニッ
トとスタンバイユニットに対して別々に行う必要があります。

• ASAにマスターパスフレーズを設定している場合は、この手順で作成したバックアップ
コンフィギュレーションの復元時にそのマスターパスフレーズが必要となります。ASA
のマスターパスフレーズが不明な場合は、マスターパスフレーズの設定を参照して、バッ

クアップを続行する前に、マスターパスフレーズをリセットする方法を確認してくださ

い。

• PKCS12データをインポート（crypto ca trustpointコマンドを使用）する際にトラストポ
イントが RSAキーを使用している場合、インポートされたキーペアにはトラストポイン
トと同じ名前が割り当てられます。この制約のため、ASDMコンフィギュレーションを復
元した後でトラストポイントおよびそのキーペアに別の名前を指定した場合、スタート

アップコンフィギュレーションは元のコンフィギュレーションと同じになるのに、実行コ

ンフィギュレーションには異なるキーペア名が含まれることになります。つまり、キー

ペアとトラストポイントに別の名前を使用した場合は、元のコンフィギュレーションを復

元できないということです。この問題を回避するため、トラストポイントとそのキーペア

には必ず同じ名前を使用してください。

• CLIを使用してバックアップしてからASDMを使用して復元したり、その逆を行うことは
できません。

•各バックアップファイルに含まれる内容は次のとおりです。

•実行コンフィギュレーション

•スタートアップコンフィギュレーション

•すべてのセキュリティイメージ

Cisco Secure Desktopおよびホストスキャンのイメージ

Cisco Secure Desktopおよびホストスキャンの設定

AnyConnect（SVC）クライアントのイメージおよびプロファイル

AnyConnect（SVC）のカスタマイズおよびトランスフォーム

•アイデンティティ証明書（アイデンティティ証明書に関連付けられた RSAキーペア
は含まれるが、スタンドアロンキーは除外される）

• VPN事前共有キー

• SSL VPNコンフィギュレーション

•アプリケーションプロファイルのカスタムフレームワーク（APCF）

•ブックマーク

•カスタマイゼーション
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•ダイナミックアクセスポリシー（DAP）

•プラグイン

•接続プロファイル用の事前入力スクリプト

•プロキシ自動設定

•変換テーブル

• Webコンテンツ

•バージョン情報

システムのバックアップ

この手順では、完全なシステムバックアップを実行する方法について説明します。

手順

ステップ 1 コンピュータ上にフォルダを作成し、バックアップファイルを保存します。こうすると、後で

復元するときに探しやすくなります。

ステップ 2 [Tools] > [Backup Configurations]を選択します。

[Backup Configurations]ダイアログボックスが表示されます。[SSL VPN Configuration]領域の下
矢印をクリックし、SSL VPNコンフィギュレーションのバックアップオプションを確認しま
す。デフォルトでは、すべてのコンフィギュレーションファイルがチェックされ、利用できる

場合にはバックアップされます。リスト内のすべてのファイルをバックアップするには、手順

5に進みます。

ステップ 3 バックアップするコンフィギュレーションを選択する場合は、[Backup All]チェックボックス
をオフにします。

ステップ 4 バックアップするオプションの横にあるチェックボックスをオンにします。

ステップ 5 [Browse Local to specify a directory and file name for the backup .zip file] をクリックします。

ステップ 6 [Select]ダイアログボックスで、バックアップファイルを格納するディレクトリを選択します。

ステップ 7 [Select]をクリックします。[Backup File]フィールドにパスが表示されます。

ステップ 8 ディレクトリパスの後にバックアップファイルの宛先の名前を入力します。バックアップファ

イルの名前の長さは、3～ 232文字の間である必要があります。

ステップ 9 [Backup]をクリックします。証明書をバックアップする場合や、ASAでマスターパスフレー
ズを使用している場合を除き、すぐにバックアップが続行されます。

ステップ 10 ASAでマスターパスフレーズを設定し、イネーブルにしている場合、バックアップを続行す
る前に、マスターパスフレーズが不明な場合は変更することを推奨する警告メッセージが表示

されます。マスターパスフレーズがわかっている場合は、[Yes]をクリックしてバックアップ
を続行します。ID証明書をバックアップする場合を除き、すぐにバックアップが続行されま
す。
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ステップ 11 ID証明書をバックアップする場合は、証明書を PKCS12形式でエンコーディングするために
使用する別のパスフレーズを入力するように求められます。パスフレーズを入力するか、また

はこの手順をスキップすることができます。

ID証明書だけがこのプロセスによってバックアップされます。（注）

•証明書を暗号化するには、[CertificatePassphrase]ダイアログボックスで証明書のパスフレー
ズを入力および確認し、[OK]をクリックします。証明書の復元時に必要となるため、こ
のダイアログボックスに入力したパスワードを覚えておく必要があります。

• [Cancel]をクリックすると、この手順がスキップされ、証明書はバックアップされません。

[OK]または [Cancel]をクリックすると、すぐにバックアップが開始されます。

ステップ 12 バックアップが完了すると、ステータスウィンドウが閉じ、[BackupStatistics]ダイアログボッ
クスが表示され、成功または失敗のメッセージが示されます。

バックアップの「失敗」メッセージは多くの場合、指定されたタイプの既存のコン

フィギュレーションが存在しない場合に表示されます。

（注）

ステップ 13 [OK]をクリックし、[Backup Statistics]ダイアログボックスを閉じます。

バックアップの復元

zip tar.gzファイルからローカル PCに復元するコンフィギュレーションやイメージを指定しま
す。

手順

ステップ 1 [Tools] > [Restore Configurations]を選択します。

ステップ 2 [Restore Configurations]ダイアログボックスで、[Browse Local Directory]をクリックし、ローカ
ルコンピュータ上の、復元するコンフィギュレーションが含まれている zipファイルを選択
し、[Select]をクリックします。[Local File]フィールドにパスと zipファイル名が表示されま
す。

復元する zipファイルは、[Tools] > [Backup Configurations]オプションを選択して作成したもの
である必要があります。

ステップ 3 [Next]をクリックします。2つ目の [RestoreConfiguration]ダイアログボックスが表示されます。
復元するコンフィギュレーションの横にあるチェックボックスをオンにします。使用可能なす

べての SSL VPNコンフィギュレーションがデフォルトで選択されています。

ステップ 4 [Restore]をクリックします。

ステップ 5 バックアップファイルの作成時に、証明書の暗号化に使用する証明書パスフレーズを指定して
いる場合は、このパスフレーズを入力するように ASDMから求められます。
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ステップ 6 実行コンフィギュレーションの復元を選択した場合、実行コンフィギュレーションを結合する
か、実行コンフィギュレーションを置換するか、または復元プロセスのこの部分をスキップす

るかを尋ねられます。

•コンフィギュレーションの結合では、現在の実行コンフィギュレーションとバックアップ
された実行コンフィギュレーションが結合されます。

•実行コンフィギュレーションの置換では、バックアップされた実行コンフィギュレーショ
ンのみが使用されます。

•この手順をスキップすると、バックアップされた実行コンフィギュレーションは復元され
ません。

ASDMでは、復元操作が完了するまでステータスダイアログボックスが表示されます。

ステップ 7 実行コンフィギュレーションを置換または結合した場合は、ASDMを閉じてから再起動しま
す。実行コンフィギュレーションを復元しなかった場合は、ASDMセッションをリフレッシュ
して、変更を有効にします。

自動バックアップおよび復元の設定（ISA 3000）
ISA 3000では、設定を保存するたびに、特定の場所への自動バックアップを設定できます。

自動復元では、完全な設定を SDフラッシュメモリカードにロードして、新しいデバイスを簡
単に設定できます。工場出荷時のデフォルト設定では、自動復元が有効になっています。

自動バックアップの設定（ISA 3000）

ISA 3000では、設定を保存するたびに、特定の場所への自動バックアップを設定できます。

始める前に

この機能は、ISA 3000のみで使用できます。

手順

ステップ 1 [構成（Configuration）] > [デバイス管理（Device Management）] > [自動バックアップと復元
の設定（Auto Backup & Restore Configuration）]の順に選択します。

ステップ 2 [自動バックアップ設定（AutomaticRestoreConfiguration）]をオンまたはオフにして、自動バッ
クアップを有効または無効にします。

自動バックアップを有効にした場合、設定を保存すると、その設定は自動的にバックアップの

場所とスタートアップコンフィギュレーションに保存されます。バックアップファイルの名前

は「auto-backup-asa.tgz」です。

次のパラメータを設定します。
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• [インターフェイス（Interface）]：オフデバイスストレージを指定した場合に、バックアッ
プ URLに到達するためのインターフェイスを指定します。interface nameを指定しない場
合、ASAは管理専用のルーティングテーブルをチェックします。ここで一致が見つから
ない場合はデータのルーティングテーブルをチェックします。

• [場所（Location）]：データのバックアップに使用するストレージメディアを指定します。
URLまたはローカルストレージを指定できます。disk0は内部フラッシュドライブです。
disk1は USB 1のオプションの USBメモリスティックです。disk2は USB 2のオプション
の USBメモリスティックです。disk3は SDメモリカードです。自動復元のデフォルトは
disk3:です。

• [パスフレーズ（Passphrase）]：バックアップデータを保護するためのパスフレーズを設定
します。自動復元のデフォルトは「cisco」です。

自動復元の設定（ISA 3000）

自動復元モードは、ユーザの操作なしでデバイスのシステム設定を復元します。たとえば、保

存したバックアップ設定を含む SDメモリカードを新しいデバイスに挿入し、デバイスの電源
をオンにします。デバイスが起動すると、システム設定を復元する必要があるかどうかを判断

するために SDカードがチェックされます。（復元は、バックアップファイルに別のデバイス
の「フィンガープリント」がある場合にのみ開始されます。バックアップファイルのフィン

ガープリントは、バックアップまたは復元操作中に現在のデバイスに一致するように更新され

ます。そのため、デバイスがすでに復元を完了している場合、またはデバイスが独自のバック

アップを作成している場合は、自動復元はスキップされます。）フィンガープリントに復元が

必要であることが示されている場合、デバイスはシステム設定を置き換えます（startup-config、
running-config、SSLVPN設定など。バックアップの内容の詳細については、システムのバック
アップ（25ページ）を参照してください）。デバイスの起動が完了すると、保存された設定
が実行されます。

工場出荷時のデフォルト設定では自動復元が有効になっているため、デバイスの事前設定を実

行しなくても、SDメモリカードにロードされた完全な設定で新しいデバイスを簡単に設定で
きます。

デバイスは、システム設定を復元する必要があるかどうかをブートプロセスの早い段階で決定

する必要があるため、ROMMON変数をチェックして、デバイスが自動復元モードかどうかを
判断し、バックアップ設定の場所を取得します。次の ROMMON変数が使用されます。

• RESTORE_MODE = {auto | manual}

デフォルトは autoです。

• RESTORE_LOCATION = {disk0: | disk1: | disk2: | disk3:}

デフォルトは disk3:です。

• RESTORE_PASSPHRASE = key

デフォルトは ciscoです。
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自動復元設定を変更するには、次の手順を実行します。

始める前に

•この機能は、ISA 3000のみで使用できます。

•デフォルトの復元設定を使用する場合は、SDメモリカード（部品番号SD-IE-1GB=）を取
り付ける必要があります。

•自動復元を有効にするためにデフォルト設定を復元する必要がある場合は、configure
factory defaultコマンドを使用します。このコマンドは、トランスペアレントファイア
ウォールモードでのみ使用できます。そのため、ルーテッドファイアウォールモードの

場合は、最初に firewall transparentコマンドを使用します。

手順

ステップ 1 [構成（Configuration）] > [デバイス管理（Device Management）] > [自動バックアップと復元
の設定（Auto Backup & Restore Configuration）]の順に選択します。

ステップ 2 [自動復元設定（Automatic Restore Configuration）]をオンまたはオフにして、自動復元を有効
または無効にします。

復元されるファイルの名前は「auto-backup-asa.tgz」です。自動復元を有効にする場合は、次の
パラメータを設定します。

• [場所（Location）]：データの復元に使用するストレージメディアを指定します。disk0は
内部フラッシュドライブです。disk1は USB 1のオプションの USBメモリスティックで
す。disk2はUSB 2のオプションのUSBメモリスティックです。disk3は SDメモリカード
です。デフォルトは disk3です。

• [パスフレーズ（Passphrase）]：バックアップデータを読み取るパスフレーズを設定しま
す。デフォルトは「cisco」です。

TFTPサーバーへの実行コンフィギュレーションの保存
この機能により、現在の実行コンフィギュレーションファイルのコピーをTFTPサーバーに保
存します。

手順

ステップ 1 [File] > [Save Running Configuration to TFTP Server]を選択します。

[Save Running Configuration to TFTP Server]ダイアログボックスが表示されます。
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ステップ 2 TFTPサーバーの IPアドレスと、コンフィギュレーションファイルの保存先となる TFTPサー
バー上のファイルパスを入力して、[Save Configuration]をクリックします。

デフォルトの TFTP設定を行うには、[Configuration] > [Device Management] >
[Management Access] > [File Access] > [TFTPClient]の順に選択します。この設定を行っ
た後は、このダイアログボックスに、TFTPサーバーの IPアドレスと TFTPサーバー
上でのファイルパスが自動的に表示されます。

（注）

システム再起動のスケジュール
System Reloadツールにより、システムの再起動をスケジュールしたり、現在の再起動をキャ
ンセルしたりできます。

手順

ステップ 1 [Tools] > [System Reload]を選択します。

ステップ 2 [Reload Scheduling]領域で、次の設定を定義します。

a) [Configuration State]では、再起動時に実行コンフィギュレーションを保存するか、破棄す
るかのどちらかを選択します。

b) [Reload Start Time]では、次のオプションから選択します。

•再起動をただちに実行するには、[Now]をクリックします。

•指定した時間だけ再起動を遅らせるには、[Delay by]をクリックします。再起動開始
までの時間を、時間と分単位、または分単位だけで入力します。

•指定した時刻と日付に再起動を実行するようにスケジュールするには、[Schedule at]
をクリックします。再起動の実行時刻を入力し、再起動のスケジュール日を選択しま

す。

c) [ReloadMessage]フィールドに、再起動時に開いているASDMインスタンスに送信するメッ
セージを入力します。

d) 再起動を再試行するまでの経過時間を時間と分単位で、または分単位だけで表示するに
は、[On reload failure force immediate reload after]チェックボックスをオンにします。

e) 設定に従って再起動をスケジュールするには、[Schedule Reload]をクリックします。

[Reload Status]領域には、再起動のステータスが表示されます。

ステップ 3 次のいずれかを選択します。

•スケジュールされた再起動を停止するには、[Cancel Reload]をクリックします。

•スケジュールされた再起動の終了後に [ReloadStatus]表示をリフレッシュするには、[Refresh]
をクリックします。
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•スケジュールされた再起動の詳細を表示するには、[Details]をクリックします。

Auto Updateの設定
Auto Updateは、Auto Updateサーバーがコンフィギュレーションおよびソフトウェアイメージ
を多数のASAにダウンロードすることを許可し、中央からのASAの基本的なモニターリング
を提供するプロトコル仕様です。

Auto Updateについて
この項では、Auto Updateの実装方法と Auto Updateが必要になる理由について説明します。

Auto Updateクライアントまたはサーバー

ASAは、クライアントまたはサーバーとして設定できます。Auto Updateクライアントとして
動作する場合は、ソフトウェアイメージおよびコンフィギュレーションファイルへのアップ

デートのため、Auto Updateサーバーを定期的にポーリングします。Auto Updateサーバーとし
て動作する場合は、Auto Updateクライアントとして設定された ASAのアップデートを発行し
ます。

Auto Updateの利点

Auto Updateは、次のように、管理者が ASAの管理で直面するさまざまな問題を解決できる便
利な機能です。

•ダイナミックアドレッシングおよび NATに関する問題点の解決。

•コンフィギュレーションの変更を 1つのアクションでコミット。

•ソフトウェア更新用の信頼度の高い方式の提供。

•ハイアベイラビリティ用の十分実績のある方式の活用（フェールオーバー）。

•オープンインターフェイスによる柔軟性の提供。

•サービスプロバイダ環境のセキュリティソリューションの簡素化。

AutoUpdate仕様は、中央、または複数の場所から、リモート管理アプリケーションによりASA
のコンフィギュレーションやソフトウェアイメージをダウンロードしたり、基本的な監視機能

を実行したりする場合に必要なインフラストラクチャです。

Auto Update仕様に従うと、Auto Updateサーバーから ASAにコンフィギュレーション情報を
プッシュしたり、要求を送信して情報を取得したりすることも、ASAから Auto Updateサー
バーに定期的にポーリングすることによって、最新のコンフィギュレーション情報を引き出す

（プルする）こともできます。また、Auto Updateサーバーはいつでも ASAにコマンドを送信
し、ただちにポーリング要求を送信させることもできます。Auto Updateサーバーと ASAの通

ソフトウェアおよびコンフィギュレーション

31

ソフトウェアおよびコンフィギュレーション

Auto Updateの設定



信では、通信パスとローカル CLIコンフィギュレーションをすべての ASAに設定する必要が
あります。

フェールオーバー設定での Auto Updateサーバーサポート

Auto Updateサーバを使用して、ソフトウェアイメージとコンフィギュレーションファイル
を、アクティブ/スタンバイフェールオーバーコンフィギュレーションの ASAに配置できま
す。アクティブ/スタンバイフェールオーバーコンフィギュレーションでAutoUpdateをイネー
ブルにするには、フェールオーバーペアのプライマリ装置に Auto Updateサーバーのコンフィ
ギュレーションを入力します。

フェールオーバーコンフィギュレーションのAutoUpdateサーバーサポートには、次の制限と
動作が適用されます。

•アクティブ/スタンバイコンフィギュレーションがサポートされるのは、シングルモード
だけです。

•新しいプラットフォームソフトウェアイメージをロードする際、フェールオーバーペア
はトラフィックの転送を停止します。

• LANベースのフェールオーバーを使用する場合、新しいコンフィギュレーションによっ
てフェールオーバーリンクのコンフィギュレーションが変更されてはいけません。フェー

ルオーバーリンクのコンフィギュレーションが変更されると、装置間の通信は失敗しま

す。

• Auto Updateサーバへの Call Homeを実行するのはプライマリ装置だけです。Call Homeを
実行するには、プライマリ装置がアクティブ状態である必要があります。そうでない場

合、ASAは自動的にプライマリ装置にフェールオーバーします。

•ソフトウェアイメージまたはコンフィギュレーションファイルをダウンロードするのは、
プライマリ装置だけです。その後、ソフトウェアイメージまたはコンフィギュレーション

ファイルはセカンダリ装置にコピーされます。

•インターフェイスMACアドレスとハードウェアのシリアル番号は、プライマリ装置のも
のです。

• Auto Updateサーバーまたは HTTPサーバーに保存されたコンフィギュレーションファイ
ルは、プライマリ装置専用です。

Auto Updateプロセスの概要

次に、フェールオーバーコンフィギュレーションでの Auto Updateプロセスの概要を示しま
す。このプロセスは、フェールオーバーがイネーブルであり、動作していることを前提として

います。装置がコンフィギュレーションを同期化している場合、SSMカードの不具合以外の理
由でスタンバイ装置に障害が発生している場合、または、フェールオーバーリンクがダウンし

ている場合、Auto Updateプロセスは実行できません。

1. 両方の装置は、プラットフォームおよび ASDMソフトウェアチェックサムとバージョン
情報を交換します。
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2. プライマリ装置は Auto Updateサーバーにアクセスします。プライマリ装置がアクティブ
状態でない場合、ASAはプライマリ装置にフェールオーバーした後、AutoUpdateサーバー
にアクセスします。

3. Auto Updateサーバーは、ソフトウェアチェックサムと URL情報を返します。

4. プライマリ装置が、アクティブまたはスタンバイ装置のプラットフォームイメージファ
イルをアップデートする必要があると判断した場合は、次の処理が実行されます。

1. プライマリ装置は、AutoUpdateサーバーのURLを使用して、HTTPサーバーから適切
なファイルを取得します。

2. プライマリ装置は、そのイメージをスタンバイ装置にコピーしてから、自身のイメー
ジをアップデートします。

3. 両方の装置に新しいイメージがある場合は、セカンダリ（スタンバイ）装置が最初に
リロードされます。

•セカンダリ装置のブート時にヒットレスアップグレードが可能な場合は、セカン
ダリ装置がアクティブ装置になり、プライマリ装置がリロードされます。リロー

ドが終了すると、プライマリ装置がアクティブ装置になります。

•スタンバイ装置のブート時にヒットレスアップグレードができない場合は、両方
の装置が同時にリロードされます。

4. セカンダリ（スタンバイ）装置だけに新しいイメージがある場合は、セカンダリ装置
だけがリロードされます。プライマリ装置は、セカンダリ装置のリロードが終了する

まで待機します。

5. プライマリ（アクティブ）装置だけに新しいイメージがある場合は、セカンダリ装置
がアクティブ装置になり、プライマリ装置がリロードされます。

6. もう一度アップデートプロセスが手順 1から開始されます。

5. ASAが、プライマリまたはセカンダリ装置の ASDMファイルをアップデートする必要が
あると判断した場合は、次の処理が実行されます。

1. プライマリ装置は、AutoUpdateサーバーから提供されたURLを使用して、HTTPサー
バーから ASDMイメージファイルを取得します。

2. プライマリ装置は、必要に応じてそのイメージをスタンバイ装置にコピーします。

3. プライマリ装置は、自身の ASDMイメージをアップデートします。

4. もう一度アップデートプロセスが手順 1から開始されます。

6. プライマリ装置が、コンフィギュレーションファイルをアップデートする必要があると判
断した場合は、次の処理が実行されます。

1. プライマリ装置は、指定された URLを使用して、からコンフィギュレーションファ
イルを取得します。
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2. 両方の装置で同時に、古いコンフィギュレーションが新しいコンフィギュレーション
に置換されます。

3. もう一度アップデートプロセスが手順 1から開始されます。

7. チェックサムがすべてのイメージおよびコンフィギュレーションファイルと一致している
場合、アップデートは必要ありません。このプロセスは、次のポーリング時間まで中断さ

れます。

Auto Updateのガイドライン

コンテキストモード

Auto Updateは、シングルコンテキストモードでのみサポートされます。

クラスタ

クラスタリングはサポートされません。

モデル

次のモデルではサポートされません。

• ASA 5506-X、5508-X、5516-X

• Firepower 1000、 2100、 4100、および 9300

• ASAv

その他のガイドライン

• Auto UpdateサーバーからASAのコンフィギュレーションが更新されても、ASDMには通
知されません。[Refresh]または [File] > [RefreshASDMwith the Running Configuration on the
Device]を選択して、最新のコンフィギュレーションを取得する必要があります。また、
ASDMでコンフィギュレーションに加えた変更は失われます。

• Auto Updateサーバーと通信するためのプロトコルとして HTTPSが選択されている場合
は、ASAは SSLを使用します。これは、ASAによる DESまたは 3DESライセンスの保有
が必須です。
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Auto Updateサーバーとの通信の設定

手順

ステップ 1 [Configuration] > [Device Management] > [System Image/Configuration] > [Auto Update]を選
択します。

[Auto Update]ペインには、[Auto Update Servers]テーブルの他に [Timeout]領域と [Polling]領域
があります。

[Auto Update Servers]テーブルで、Auto Updateサーバーにすでに設定されているパラメータを
確認できます。ASAは、テーブルの一番上にあるサーバーを最初にポーリングします。

ステップ 2 テーブル内のサーバーの順序を変更するには、[Move Up]または [Move Down]をクリックしま
す。

[Auto Update Servers]テーブルには次のカラムがあります。

• [Server]：Auto Updateサーバーの名前または IPアドレス。

• [User Name]：Auto Updateサーバーのアクセス時に使用されるユーザー名。

• [Interface]：Auto Updateサーバーへの要求送信時に使用されるインターフェイス。

• [Verify Certificate]：Auto Updateサーバが返した証明書を、ASAでCAのルート証明書と照
合して確認するかどうかを指定します。Auto Updateサーバおよび ASAは同じ CAを使用
する必要があります。

ステップ 3 [AutoUpdate Server]テーブルの行のいずれかをダブルクリックすると、[Edit AutoUpdate Server]
ダイアログボックスが開き、Auto Updateサーバーのパラメータを変更できます。ここで行っ
た変更はただちにテーブルに反映されますが、コンフィギュレーションに保存するには [Apply]
をクリックする必要があります。

ステップ 4 [Timeout]エリアでは、ASAが Auto Updateサーバーのタイムアウトを待つ時間を設定できま
す。[Timeout]領域には次のフィールドがあります。

• [Enable Timeout Period]：ASAが Auto Updateサーバーから応答を受信しなかった場合にタ
イムアウトするには、オンにします。

• [Timeout Period (Minutes)]：Auto Updateサーバーから応答がなかった場合の ASAのタイム
アウト時間（分単位）を指定します。

ステップ 5 [Polling]エリアで、ASAから Auto Updateサーバーの情報をポーリングする頻度を設定できま
す。[Polling]領域には次のフィールドがあります。

• [Polling Period (minutes)]：ASAから Auto Updateサーバーに新しい情報をポーリングする
ときの待ち時間（分単位）。

• [Poll on Specified Days]：ポーリングのスケジュールを指定します。
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• [Set Polling Schedule]：[Set Polling Schedule]ダイアログボックスが表示され、Auto Update
サーバーをポーリングする日付と時刻を設定できます。

• [Retry Period (minutes)]：サーバーのポーリングに失敗した場合、ASAからAutoUpdateサー
バーに新しい情報をポーリングするまでの待ち時間（分単位）。

• [Retry Count]：ASAから Auto Updateサーバーに新しい情報をポーリングするときの再試
行回数。

ステップ 6 ポーリングスケジュールの設定

[Set Polling Schedule]ダイアログボックスでは、ASAからAuto Updateサーバーをポーリングす
る特定の日付と時刻を設定できます。

[Set Polling Schedule]ダイアログボックスには次のフィールドがあります。

[Days of the Week]：ASAから Auto Updateサーバーをポーリングする曜日のチェックボックス
を選択します。

[Daily Update]ペイングループでは、ASAが Auto Updateサーバーをポーリングする時刻を設
定できます。次のフィールドがあります。

• [Start Time]：Auto Updateのポーリング開始時刻を入力します。

• [Enable randomization]：ASAから Auto Updateサーバーをランダムに選択した時刻にポー
リングするには、オンにします。

Auto Updateのモニターリング

Auto Updateプロセスのモニターリング

debug auto-update clientまたは debug fover cmd-exeコマンドを使用して、Auto Updateプロセ
スで実行される処理を表示できます。次に、debug auto-update clientコマンドの出力例を示し
ます。debugターミナルセッションからコマンドを実行します。

Auto-update client: Sent DeviceDetails to /cgi-bin/dda.pl of server 192.168.0.21
Auto-update client: Processing UpdateInfo from server 192.168.0.21

Component: asdm, URL: http://192.168.0.21/asdm.bint, checksum:
0x94bced0261cc992ae710faf8d244cf32

Component: config, URL: http://192.168.0.21/config-rms.xml, checksum:
0x67358553572688a805a155af312f6898

Component: image, URL: http://192.168.0.21/cdisk73.bin, checksum:
0x6d091b43ce96243e29a62f2330139419
Auto-update client: need to update img, act: yes, stby yes
name
ciscoasa(config)# Auto-update client: update img on stby unit...
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 1, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 1001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 1501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 2001, len = 1024
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auto-update: Fover copyfile, seq = 4 type = 1, pseq = 2501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 3001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 3501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 4001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 4501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 5001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 5501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 6001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 6501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 7001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 7501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 8001, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 8501, len = 1024
auto-update: Fover copyfile, seq = 4 type = 1, pseq = 9001, len = 1024
auto-update: Fover file copy waiting at clock tick 6129280
fover_parse: Rcvd file copy ack, ret = 0, seq = 4
auto-update: Fover filecopy returns value: 0 at clock tick 6150260, upd time 145980 msecs
Auto-update client: update img on active unit...
fover_parse: Rcvd image info from mate
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
auto-update: HA safe reload: reload active waiting with mate state: 20
Beginning configuration replication: Sending to mate.
auto-update: HA safe reload: reload active waiting with mate state: 50
auto-update: HA safe reload: reload active waiting with mate state: 50

auto-update: HA safe reload: reload active waiting with mate state: 80
Sauto-update: HA safe reload: reload active unit at clock tick: 6266860

Auto-update client: Succeeded: Image, version: 0x6d091b43ce96243e29a62f2330139419

Auto Updateプロセスが失敗すると、次の syslogメッセージが生成されます。

%ASA4-612002: Auto Update failed: file version: version reason: reason

fileは、失敗したアップデートに応じて “image”、“asdm”、または “configuration”になります。
versionは、アップデートのバージョン番号です。reasonは、アップデートが失敗した原因で
す。

ソフトウェアおよびコンフィギュレーション

37

ソフトウェアおよびコンフィギュレーション

Auto Updateプロセスのモニターリング



ソフトウェアとコンフィギュレーションの履歴

機能情報

プラット

フォームリ

リース機能名

SCPサーバとの間でファイルを転送するため、ASAは
SecureCopy（SCP）クライアントおよびサーバをサポー
トするようになりました。

次の画面が変更されました。

[Tools] > [File Management] > [File Transfer] > [Between
Remote Server and Flash] [Configuration] > [Device
Management] > [Management Access] > [File Access] >
[Secure Copy (SCP) Server]

9.1(5)/9.2(1)セキュアコピークライアントおよびサーバ

ユーザーは SSH暗号化を管理するときに暗号化モード
を選択し、さまざまなキー交換アルゴリズムに対して

HMACと暗号化を設定できます。アプリケーションに
応じて、暗号の強度を強くしたり弱くする必要がある場

合があります。セキュアなコピーのパフォーマンスは暗

号化アルゴリズムに一部依存します。デフォルトで、

ASAは 3des-cbc aes128-cbc aes192-cbc aes256-cbc aes128-ctr
aes192-ctr aes256-ctrの順にアルゴリズムをネゴシエート
します。提示された最初のアルゴリズム（3des-cbc）が
選択された場合、aes128-cbcなどの一層効率的なアルゴ
リズムが選択された場合よりも大幅にパフォーマンスが

低下します。たとえば、提示された暗号方式に変更する

には、ssh cipher encryption custom aes128-cbcを使用し
ます。

次の画面が導入されました。[Configuration] > [Device
Management] > [Advanced] > [SSH Ciphers]

9.1(7)/9.4(3)/9.5(3)/9.6(1)設定可能な SSH暗号機能と整合性アルゴリ
ズム
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機能情報

プラット

フォームリ

リース機能名

Auto Updateサーバ証明書の検証がデフォルトでイネー
ブルになりました。新しいコンフィギュレーションでは

証明書の検証を明示的にディセーブルにする必要があり

ます。証明書の確認をイネーブルにしていなかった場合

に、以前のリリースからアップグレードしようとする

と、証明書の確認はイネーブルではなく、次の警告が表

示されます。

WARNING: The certificate provided by the
auto-update servers will not be verified.
In order to verify this certificate please
use the verify-certificate option.

設定を移行する場合は、次のように確認なしを明示的に

設定します。

次の画面が変更されました。[Configuration] > [Device
Management] > [System/ImageConfiguration] > [AutoUpdate]
> [Add Auto Update Server]。

9.2(1)デフォルトでイネーブルになっている Auto
Updateサーバー証明書の検証

CLIを使用してイメージや証明書を含む完全なシステム
コンフィギュレーションをバックアップおよび復元でき

るようになりました。

変更された ASDM画面はありません。

9.3(2)CLIを使用したシステムのバックアップと復
元

新しいASA 5506W-Xイメージのリカバリおよびロード
がサポートされています。

変更された ASDM画面はありません。

9.4(1)新しいASA 5506W-Xイメージの回復および
ロード

バックアップコマンドと復元コマンドのプリセットパ

ラメータを使用して、自動バックアップ機能や自動復元

機能を有効にできます。これらの機能は、外部メディア

からの初期設定、デバイス交換、作動可能状態へのロー

ルバックなどで使用されます。

次の画面が導入されました。[Configuration] > [Device
Management] > [Auto Backup & Restore Configuration]

9.7(1)ISA 3000の自動バックアップと復元
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